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1. Disclaimer
In no event shall NavSync, subsidiaries or The Connor-Winfield Corporation holding company be liable for any loss 
of profit or any other commercial or private damage, including but not limited to special, incidental, consequential or 
other damages, resulting from or in any way connected with the use of this software. NavSync specifically disclaims 
any other warranties expressed or implied, including but not limited to the implied warranties of merchantability 
and fitness for a particular use.

2. Distribution
You are hereby licensed to make as many copies of the NS3Kview software and documentation as you wish; give 
exact copies of the original version to anyone; and distribute the NS3Kview software and documentation in its 
unmodified form via electronic means. You are specifically prohibited from changing any wording from the original 
supplied documentation. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however made; and 
from distributing the software and/or documentation with other products (commercial or otherwise) without prior 
written permission.

3. Installing NS3Kview
The software is supplied on a CD-ROM and www.navsync.com, and is very simple to install.

Insert the CD into the CD-ROM drive and view the disk contents. Run the NS3Kview installation.EXE program, this 
will guide you through the installation process. The software is normally installed into the Program Files\NS3Kview 
directory but may be installed into any directory you choose.

The program is self-contained and requires no proprietary library files (DLL’s).
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Figure 1: NS3Kview Window

NS3Kview Quick Start Guide

4. Introduction
NS3Kview is a general purpose utility for monitoring the output from a GPS receiver especially the NavSync CW25 
receiver. The software is designed to run under Windows 95/98 and NT operating systems.

NS3Kview uses the serial protocol from the National Marine Electronics Association (NMEA) version 2.20. NS3Kview 
is set up as a listener and will show information by interpreting the following sentences:

GPGGA - Global Positioning System fix data
GPGSA - GNSS DOP and active satellites
GPGSV - GNSS satellites in view
GPRMC – Minimum required sentence
POLYA – GPGGA with additional estimated accuracy
POLYP – NavSync proprietary status message
POLYS – NavSync proprietary satellite status message (GPGGA + GPGSV)

NS3Kview is not navigation based software, but a statistical analyst software package that can report position 
errors, antenna obstructions and log NMEA data to a file. It is not necessary to have a GPS receiver connected to 
the computer to acquire data. Using captured NMEA data, NS3Kview will process through the data as if it were 
connected to a GPS receiver.

NS3Kview has four major windows. “Signal Quality”, “Navigation”, “Survey”, “Azimuth and Elevation”. By clicking 
on the tool-bar or on the correct window under the “View” menu option, these windows will enable or brought into 
focus. Each window has its own abilities and functionality. Some windows like the “Survey” window have pop-up 
menus that you can enable by using the right mouse button.
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5. Getting Started
NS3Kview has two modes of operation: NS3Kview communicating with a GPS receiver and NS3Kview reading 
NMEA sentences from a file. For NS3Kview to communicate with a GPS receiver, the GPS receiver must have 
ability to send NMEA data sentences.

First step is to connect the GPS receiver to the computer.

The CW25 Development Kit comes complete with serial cables to connect your CW25-DB to the PC. Connect the 
breakout adaptor between DB15M port on the CW25-DB and COM1 (or other as desired) on the PC.

NS3Kview must be configured to use the correct communication port of the PC. Select the communications option 
under the “Settings” menu and set the Com Port to COM1 (or other as desired) on the PC that has the same port 
as the CW25-DB is connected to.

If no GPS receiver is present, NS3Kview has the ability to read a text file containing NMEA messages, demo mode. 
This is also accessed from the “Communications Settings” dialog box.

The default communication settings for ports of the CW25 receiver are 38400 baud, 8 data bits, 1 stop bit and no 
parity. NS3Kview will remember these communications settings and will start listening for NMEA sentences once 
the program starts.

Figure 2: Communications Settings
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Figure 3: New Dialog
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6. New Dialog
From the “File” menu, select “New”. Here you can open one of many different NS3Kview windows.
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7. Settings

7.1 Communications Settings
Here you can set up the communications interface. The default communications parameters for the three port of the 
NavSync CW25 Development Kit is 38400 baud, no parity, 8 data bits, 1 stop bit. This setting is introduced in Section 
13.5 Connecting NS3Kview to a GPS Receiver. Here, “NMEA File Logging” and “Demo Mode” can be selected.

7.1.1 NMEA File Logging
NS3Kview will log all the NMEA sentences it receives to a file. This feature is also found in the “Communication 
Settings” option. By checking the “Enable Logging” check box and use the q button to select the destination 
for the log file. A log file will be opened and NMEA data can be saved to that file.

This file can be used in playing back the data through the demo mode option. See below.

NMEA logging can also be selected through the “NMEA Command Monitor Window” that will show in detail in 
Section 10.3.

7.1.2 Running NS3Kview in Demo Mode
If no GPS receiver is present, then NS3Kview will run in a demo mode of operation using a NMEA text file as 
input. NS3Kview provides a default file NMEA.TXT. This file has about five hours of data collected. Other NMEA 
text files may be used if desired. The NMEA.TXT file is provided for demonstration purpose and can be deleted.

To run NS3Kview in demo mode:

1.	 Select the “Communications” option under the “Settings” menu.

2.	 Check the “Enable Demo Mode” check box.

3.	 Click on the “Browse” button.

4.	 Select “NMEA.txt” file and click on “Open”. The file name will now read in the “NMEA Capture” file edit box.

5.	 Click on “OK”

NOTE:
When NS3Kview is in demo mode and reading a file, it reads the file at a very fast rate and ignores time. One minute of acquired data will 
read in a few seconds. This will allow a time lapse view of the captured data.

7.1.3 Demo Mode
“Demo Mode” or “NMEA Data Play-Back” will read a text file for NMEA data sentences. Checking the “Enable 
Demo Mode” check box will command NS3Kview to read a text file instead of reading the communication port. 
This is useful in situations that need to demonstrate the software in the absence of a receiver or have a limited 
sky view. A file is included for demonstration purposes. Selecting the “Browse” button will allow you to select 
your own NMEA text file.

The rate that NS3Kview will read the file can be controlled by setting the wait and delay values. Note that individual 
NS3Kview windows will update at a maximum of 100 ms and data may be discarded in any intervals shorter than 
100 ms. For example, the “Survey Window” will read the NMEA data processing every 100 ms while the “Signal 
Quality Window” will read the NMEA data processing every second. Of course, this depends on the processing 
power of the target computer.
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Figure 4: GPS Settings
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7.2 General Settings
The general settings dialog allows the user to set-up various parameters for NS3Kview.

7.2.1 Units of Measure

Here you can select metric or statute units. Any values that reflect altitude or distance will be affected.

7.3 GPS Settings
The “GPS Settings” dialog allows the user to configure the receiver to output their NMEA sentences, or initialize it 
with time and position etc. At this time, GPS receivers supported are the CW25 or any generic receivers that accept 
ASCII initialization commands. Future versions of NS3Kview will support more GPS receivers.

To configure a receiver, type in the required command and select the “Carriage Return” (CR) and “Line Feed” (LF) 
options as applicable (The CW25 requires both these options to be set). Select the “Add” button to add this 
command to the list. Up to 10 commands can be added to the list. Once you have entered the required commands, 
select the “Apply” button to send these commands to the receiver.

If you have selected a NavStream 3000 receiver in the “GPS Receiver Model”, a list of the more commonly used 
commands will be displayed above the command entry box, the CW25 supports a subset of these commands.
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Selecting an option from the list of commands will display a sample of the command in the command entry box. 
This can be edited to have the correct data and then added to the list with the “Add” button. To see details of these 
message formats select the “Help” button, this will show the specification for each message.

To edit a command which has already been entered into the command list, highlight the command and select the 
“Edit” button. This removes the command from the list and places it in the command entry box, edit the command 
as required and when modified select the “Add” button to add it back to the list.

NavSync’s CW25 receiver acknowledges commands by returning a $PRTHR message corresponding to the 
command sent. These messages are decoded by NS3Kview and displayed in the “Command Response” window. 
These can be checked against the commands sent to the receiver to see if all commands have been accepted. To 
become familiar with the messages, send a few commands to the receiver and observe the responses.

To automatically send initialization commands when NS3Kview is started, select the “Enable GPS” initialization on 
start-up button.

7.4 NMEA Settings
The “NMEA Settings” dialog will enable or disable processing of individual NMEA sentences. To disable processing 
of specific sentence, select the sentence in “Include” list box and click on the button. To enable processing of a 
specific sentence, select the sentence in the “Exclude” box and click on the "” button.

8. GPS LED Indicator
This LED indicates that there are NMEA sentences received by NS3Kview. When the LED blinks green, a NMEA 
sentence is received. When the LED is grey, no sentences have been received within 10 seconds.

9. NMEA Logging LED
The NMEA logging LED indicates that the NMEA logging is enabled. When the LED blinks red, active logging is 
enabled.

Under the View menu, six windows can show the signal information: “Navigation Window”, “Survey Window”, 
“NMEA Command Monitor Window”, “Signal Quality Window”, “Satellite Azimuth and Elevation Window” and “TTFF 
Window”. The functionality of these windows is shown in the following Section 10 Windows.
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Figure 5: Navigation Window

Figure 6: Survey Window

10. Windows

10.1 Navigation Window
The “Navigation Window” shows the current time, clock drift, longitude, latitude and altitude or elevation. These 
values will update each time the GPS receiver sends the GPGGA or POLYP messages. The size of the font used is 
proportional to the window size. To change the font size, simply change the size of the window.

10.2 Survey Window
The “Survey Window” will log latitude, longitude and altitude displaying data graphically. The latitude/longitude 
display contains a scale in meters/feet as well as position grids in degrees. The “Survey Window” is split into three 
frames. See Figure 6
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At the top is the “Survey” frame, which is a plot of position history is graphically displayed, known as paths. These 
paths can be saved to disk and viewed at a later time. 

The frame below left of the “Survey” frame is the “Elevation” frame. This frame simply plots the altitude.

To the right of the “Elevation” frame is the “Position Statistics” frame. Displayed here are position average and 
Dilution Of Precision (DOPs).

10.2.1 Survey Frame
NS3Kview has the ability to display the average position and altitude data. NS3Kview uses two methods of 
averaging – “Mean” average and “Least Squares” average. These averages are graphically displayed in the 
“Survey” frame and in text in the “Statistics” frame.

The standard deviation shows how much the position is moving around. Graphically, the “Standard Deviation” 
is displayed in the “Survey” and “Elevation” frame. For a normal curve, 68.27% (one sigma) of the cases are 
included within the areas (the round circles in the “Survey” frame, which is a red circle on the screen between 
the two thick black lines in the “Elevation” frame).

It is also possible to display the “Estimated Accuracy” of the GPS solution provided this information is available. 
The NavSync proprietary POLYP and POLYA messages include an estimated horizontal accuracy field in meters. 
When the “Estimated Accuracy” display is enabled, the horizontal estimated accuracy is displayed as a circle 
around the current position. This option can be switched “On” or “Off” from the popup or main menu.

10.2.2 Cursor
By moving the cursor over the “Survey” frame, the latitude and longitude are displayed at the bottom of the main 
application window. Clicking the left mouse button will place a distance marker where the current cursor position 
is used as a distance measurement. The distance is also displayed at the bottom the application main window.

Using the right mouse button, a command menu is enabled. This is the same as the “Survey Settings” in the 
survey menu bar. The following options may be selected:

	 10.2.2.1 Enable Least Squares Fit Average Indicator
This indicator is the black circle shown in “Survey” frame.

	 10.2.2.2 Enable Position Average Indicator
This indicator is the green circle shown in “Survey” frame.

	 10.2.2.3 Enable Position Accuracy Indicator
This indicator is the red circle shown in “Survey” frame.

	 10.2.2.4 Auto Scale
In normal operation the window will automatically scale to show the complete scatter plot, this can be turned on 
and off by selecting the “Auto Scale” option. If the “Auto Scale” option is switched off, and the current position 
goes outside of the graphical display, it will not be re-scaled.

	 10.2.2.5 Zoom In & Zoom Out
To zoom in to a particular area of the “Survey Window” select the “Zoom In” option and to enlarge the displayed 
area select the “Zoom Out” option. The zoom functions will use the cursor position when the right mouse key 
was selected as the central point for the zoom function. If the zoom functions are selected from the “Main 
Menu” rather than the popup menu, the current position is used as the central point.

	 10.2.2.6 Pan
The “Pan” option moves the current cursor position to the center of the survey window, the scale remain the same.

	 10.2.2.7 Refresh Screen
Occasionally the survey screen can become corrupted, especially if other windows and dialog boxes are 
positioned on top of it. To clean up the display, select the “Refresh Screen” option of the popup menu.

	 10.2.2.8 Properties
See section 10.2.3 Survey Window Properties for more information.
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10.2.3 Survey Window Properties
The “Survey Window” has several items that can be configured. Below is a description of these items and how 
they can be configured. The items that reflect the display of the survey plot also are applied to printing.

	 10.2.3.1 Position Plot Tab

		  10.2.3.1.1 Enable Position Acquisition
	 When disabled, the “Survey Window” will stop acquiring position fixes.

		  10.2.3.1.2 Validate Each Position Using GSA – GPS Quality
When enabled, each position fix is validated using the GPGSA or POLYP NMEA sentence. The GPGSA 
and POLYP sentences have a parameter that indicates that the position from the GPS receiver is valid.

		  10.2.3.1.3 Plot Indicator
The “Large” and “Small” radio buttons set the size of each position sample.

When the “Use Lines” check box is selected, a line is drawn between each position sample.

	 10.2.3.2 Position Average Tab

		  10.2.3.2.1 Lat/Lon Average HDOP Threshold
The HDOP parameter is used to weigh or place a threshold on each position fix for averaging. The threshold 
value will allow all latitude and longitude position fixes with the HDOP less than or equal to the threshold 
to be used in the averaging solution.

		  10.2.3.2.2 Elevation Average VDOP Threshold
The VDOP applies to only the elevation. The VDOP threshold will allow only the elevation samples less than 
or equal to the specified threshold value to be used in the averaging solution.

Both these parameters are extracted from the GPGSA NMEA sentence.

	 10.2.3.3 Printing Tab
Text in the “Comments” field will be printed as annotations. Up to 511 characters may be used including 
carriage returns.

	 10.2.3.4 Truth Position
	 Latitude, longitude, altitude, use truth position (mean & TTFF)

10.2.4 Printing
The “Survey Window” supports print preview and print. Both the survey path and the altitude are included in 
the printing. To print a survey plot, make sure the “Survey Window” is selected. You can do this by clicking your 
mouse anywhere on the “Survey Window”. Next, select “Print” from the file menu. Follow the instructions in the 
dialog boxes.
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10.3 NMEA Command Monitor Window
The “NMEA Command Monitor Window” shows all NMEA data sentences received from the GPS receiver. Although 
NS3Kview only responds to specific NMEA sentences, the “NMEA Command Monitor Window” will show all sentences.

Using the right mouse button, a “Command” menu is enabled. This is the same as the “Command Monitor Settings” 
in the “NMEA Command Monitor” menu bar. The following options may be selected:

10.3.1 Start Log File
This command will enable NMEA logging. Logging is an application level command and logging will continue even 
when the “NMEA Command Monitor Window” is closed. NMEA logging can also be found in the “Communications 
Dialog”. See “Getting Started” for more information.

10.3.2 Close Log File
If a log file is enabled, then selecting this menu option will close the file.

10.3.3 Pause
Pauses the “NMEA Command Monitor”. This has no effect on NMEA logging.

10.3.4 Erase Screen
This menu option simply erases the “NMEA Command Monitor Window”. This command has no effect on NMEA 
logging.

10.3.5 Debug Monitor
Enables the “Debug Monitor” mode. In this mode NMEA messages are not decoded. This “Debug” mode is 
intended for displaying special debug messages available from the NavSync range of GPS receivers. These 
messages are output in ASCII format with a “home” character at the start of each message. When set to “Debug 
Monitor” mode the “NMEA Command Monitor Window” will recognize the “home” character and start each 
message at the beginning of the window. When the “Debug Monitor” is first selected, a command is sent to the 
receiver asking it to display the menu debug page. 
Note: The receiver has to be previously configured to output the debug messages before using the debug monitor mode; alternatively the user 
through this interface can type the correct command in.

Any keyboard input in the “NMEA Command Monitor Window” is sent to the GPS receiver.

10.4 Signal Quality Window
The “Signal Quality Window” uses the GPGSV NMEA message to extract the signal to noise ratio (SNR C/No) which 
is specified as a number from 0 - 99 dB. Depending on the number of satellites in view, the number of SNR bars will 
vary. At the top of each SNR bar, the raw SNR value is displayed. Full scale is considered any SNR value of 50 dB or 
above. At the bottom of each bar shows the satellite ID.

The signal quality bar will change its color depending if the satellite is used in the navigation solution returned by 
the GPGSA NMEA message. Orange bar means the satellite is not used. Grey bar means the satellite is available 
for use, but no ephemeris. Blue bar means the satellite is used in solution. See Figure 7.
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Figure 7: Signal Quality Window
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SNR values may vary for different GPS manufactures. Not all GPS receiver manufactures return the same SNR 
values for a given location or antenna. The NMEA specification for these values states that the value must fall 
between 0 and 99 dB. CW25 will return a value between 30 and 55 while others receivers may return a value between 
0 and 35. It may be a good idea to observe the GPS receivers SNR values to see where they fall.

10.4.1 Signal Quality Properties

	 10.4.1.1 Upper and Lower Threshold
It may be necessary to adjust the minimum and maximum thresholds of the SNR values so they will yield a 
reasonable signal quality bar. By setting these values, the signal quality bar will adjust itself accordingly. To 
change the settings right click the mouse button when pointing to the SNR window. Select the properties option 
and enter in the required minimum and maximum values.

	 10.4.1.2 Auto Track
The “Auto Track” option will self adjust the thresholds. When “Auto Track” is enabled, the upper threshold and 
lower threshold are equated to the observed maximum and minimum values. When in doubt on SNR values, 
use this function.

	 10.4.1.3 Observed Minimum/Maximum
Shows the minimum and maximum values of the SNR values from the GPS receiver.

10.4.2 Reset Observed Min/Max
Right click the mouse button in the “Signal Quality Window” to choose this option to reset the minimum and 
maximum values of the SNR values.

10.5 Satellite Azimuth & Elevation Window
Like the “Signal Quality Window”, the “Satellite Azimuth & Elevation Window” will use the GPGSV NMEA message 
or the POLYS message to extract azimuth and elevation for each satellite that is in view Each satellite is identified 
by satellite ID with the “Azimuth” as the letter ‘A’ and the “Elevation” as the letter ‘E’.
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10.5 Satellite Azimuth & Elevation Window continued
The color of the text for each satellite indicates whether the satellite is used in the position solution. When the 
text is in green, the satellite is used in the solution. When the text is in red, the satellite is not used in the solution. 
The “Satellite Azimuth and Elevation Window” will show graphically the physical GPS elevation mask angle using 
a blue line. This is a way for stationary stations to check for obstructions to the GPS antenna. To calculate the 
physical elevation mask, NS3Kview will look at the signal quality (SNR) and check if it falls within the criteria of a 
valid satellite. A valid satellite is when the SNR value is larger than the SNR threshold. Right click the mouse button 
in the window can enable physical elevation mask angle or clear it.

Figure 8: Azimuth and Elevation Window

10.5.1 Satellite Azimuth & Elevation Properties Dialog

	 10.5.1.1 Physical GPS Mask Angle Tab
By setting the SNR threshold, the physical elevation mask angle can be detected and plotted. When this 
value is set to a high SNR value, the elevation mask may be more apparent in less time. The comment will be 
displayed at the top of the page. This is a good place to describe the plot and add notes. And the comments 
can be printed when printing the Azimuth and Elevation plot of the physical mask angle.

	 10.5.1.2 Auto Load Tab
The “Auto Load” feature will load the previous saved file. Sometimes it is desirable to have this file load 
automatically when the “Azimuth and Elevation Window” is opened. Check the “Enable Auto Load” check box 
to enable this feature. Use the “Browse” button to specify a file to load.

10.6 TTFF Window
“TTFF Window” allows selecting test mode. “Hot TTFF”, “Warm TTFF” and “Cold TTFF” can be checked in this 
window. These three options have different reset function. 

For more detail of the software, please go to “Help” in NS3Kview.

Figure 9: TTFF Window



Revision	 Revision Date	 Notes
P00	 6/1/11	 Preliminary Release

NavSync, Ltd. Europe
Bay 143
Shannon Industrial Estate
Shannon, Co. Clare, Ireland
Phone: +353 61 475 666
E-mail: sales@navsync.com

North America
2111 Comprehensive Drive 

Aurora, IL 60505, USA
Phone: 630.236.3026

E-mail: northamerica@navsync.com

www.navsync.com

NS3Kview 
Quick-Start Guide
 Issue:  P00


